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Introducing the NEW and improved Perfect Photo Suite 7! With seven powerful products, photographers can 
maximize their creativity, solve the most common problems in digital photography, and ultimately realize their 
photographic vision.

With Perfect Photo Suite 7, you can:

• Create and work with layered files 
• Develop stunning black and white images
• Retouch portraits
• Stylize images with photographic effects
• Remove unwanted backgrounds
• Add realistic depth of field after the shot
• Resize images up to 1000% and prepare them for print
• Work directly with Adobe® Photoshop®, Lightroom®, Photoshop Elements, Apple® Aperture® or as a 

standalone application

Perfect Photo Suite 7 Includes:

NEW! Perfect B&W
Develop classic black & white looks instantly with a library of expertly crafted effects or 
customize your own unique look using powerful, darkroom-inspired controls that replicate 
time-honored processing techniques. 

NEW! Perfect Portrait 2
Get simply powerful portrait retouching with automated face and feature detection, and 
enhancement tools. With Perfect Portrait, you can quickly and easily smooth skin, remove 
blemishes, correct skin color, and brighten eyes and teeth.

NEW! Perfect Layers 3
Enjoy all the benefits of a layered workflow with Perfect Layers 3. Combine, composite, 
blend, and retouch images—all without Photoshop. You can create and edit multilayered 
files directly from Lightroom, Aperture, or Perfect Layers as a standalone application. 

NEW! Perfect Effects 4
Enhance and stylize images with a robust library of photographic effects and powerful tools 
that allow you to combine, blend, stack and paint-in effects to create the look you want. 

Improved! Perfect Mask 5.2
Perfect Mask is the next generation of Mask Pro—the leading software for background 
replacement—that allows you to create high quality masks and remove backgrounds with 
amazing accuracy, even around tough subjects like hair, trees and glass.

FocalPoint 2
Create realistic selective focus, blur, depth-of-field, and vignette effects that tell your 
viewers right where to look. Get a tilt-shift effect with the intuitive FocusBug and use the 
FocusBrush to apply the blur right where you want it quickly and easily.

NEW! Perfect Resize 7.5 
Perfect Resize is renowned across the photographic and printing industries for its ability to 
increase image size well over 1000% without loss of detail or clarity. It is ideal to resize and 
prepare all images for print, whether shot with a DSLR camera or a mobile device.
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What’s New in Perfect Photo Suite 7

Perfect Photo Suite 7 was redesigned to better meet the needs of the many types of photographers—from 
beginning hobbyists to advanced amateurs to working professionals. It offers new and improved products, a 
redesigned user interface, new capabilities requested by users, improved performance, and improved 
integration with Lightroom and Aperture.

NEW Perfect B&W
The newest addition to Perfect Photo Suite 7—Perfect B&W includes more than 70 built-in, one-click, black and 
white effects for instant results. Powerful manual controls that help a user recreate time-honored processing 
techniques—such as Tone, Color Response, and Film Grain—are also available.

NEW Perfect Effects 4
Creative editing options are extended with new blending modes, paint-in effects, and an improved library of 
effects, borders, and textures. Effects can be found quickly and easily with an improved browser, built-in search, 
and their ability to be saved as Favorites.

NEW Perfect Portrait 2
Improved automated enhancements, new feature selection tools, and improved processing speeds allow for 
faster and flawless portrait retouching. 

NEW Perfect Layers 3
The new image browser and built-in search functionality make it easier to create and work with layered files. 
Extend your creative editing options with new blending modes, textures, borders, PNG file support, and the 
powerful new edge-detecting Perfect Brush.

NEW Perfect Resize 7.5
Faster processing speeds and factory presets for specific printer manufacturers, paper types, and other output 
methods—are now available. Get the best quality enlargements for your every photo, whether taken with a DSLR 
camera or mobile phone, and have everything you need to prepare them for print.

Redesigned User Interface
A dark gray interface with tool panes readily accessible and adjustable in size allows users to stay focused on 
editing their images. In most of the modules, tools for instant and quick adjustments—including effects and 
adjustment brushes—live on the left side of the workspace, while sliders and selections for manual adjustments 
live on the right.

Round-trip Editing from Lightroom and Aperture
With Perfect Photo Suite 7 Premium Edition and Perfect Photo Suite for Lightroom & Apertrue, images can be 
sent to the Perfect Photo Suite 7 module of choice directly from Lightroom or Aperture, where adjustments can 
be made, then returned to your image library seamlessly.

Perfect Brush
Precise edge-detected masking can be achieved with the NEW Perfect Brush. It will smoothly apply or remove 
adjustments to the specific area you're working on without crossing over the edges around it. Available in Perfect 
B&W, Perfect Portrait 2, Perfect Layers 3, and Perfect Effects 4.

Favorites
Favorite effects, presets, and extras may be flagged to reside in your own Favorites folder so they are readily 
available and easily accessible. 

Integrated Frames, Borders and Edges
The most popular frames, borders and edges from PhotoFrame 4.6 may now be added to images while working 
in Perfect B&W, Perfect Layers 3, and Perfect Effects 4.
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System Requirements

Mac OSX

• Current maintenance release of OS X 
10.6, 10.7, 10.8 (64 bit only)

• Intel Core 2 Duo, Xeon or better 
processor(s)

• 4 GB RAM (8 GB+ recommended)

• 1.5 GB of available hard disk space

• OpenGL 2.0 capable video card with 
256 MB dedicated VRAM, 1280x720 
resolution or higher

Windows

• Current maintenance release of 
Windows Vista, Windows 7 or 
Windows 8 

• Intel Core 2 Duo, Xeon or better 
processor(s)

• 4 GB RAM (8+ GB recommended)

• 1.5 GB of available hard disk space

• OpenGL 2.0 capable video card with 
256 MB dedicated VRAM, 1280x720 
resolution or higher 

Optional Integration

• Photoshop® CS4, CS5, CS6, & 
Creative Cloud*

• Photoshop® Elements 9, 10, or 11

• Photoshop® Lightroom® 2, 3, 4, and 
5*

*When available



New in the 7.5 update

Quick View Browser
The new Quick View Browser is available in Perfect Layers, Perfect Effects, and Perfect B&W. In Perfect Layers, it 
makes it easier to browse image folders and navigate to specific images.

Refined Perfect Brush
In Suite 7.5, the Perfect Brush has been refined to provide even greater control. The size of the Perfect Brush 
may now be enlarged to 2500 pixels from the previous size of 500 pixels.

The Perfect Brush can now also automatically detect and protect edges using color sampling. Previously, the 
Perfect Brush only allowed for continuous sampling of colors that were recognized under the center of the 
brush. By simply holding down Command (Mac) or Ctrl (Win) Key while using the Perfect Brush, the brush will 
lock the sampled color until the key is released. This is helpful when brushing through complex areas such as 
branches and window panes.

Red Eye Tool
Available in both Perfect Portrait and Perfect Layers. The Red Eye Tool lets you minimize the red eyes that can 
ruin an otherwise perfect picture. 

Clone Brush
The new Clone Brush in Perfect Layers allows the ability to realistically copy areas in images. This allows easy 
removal of unwanted items or the duplicatation of objects in images for creative results.

In Perfect Effects and Perfect B&W, the Quick View Browser offers previews of different effects on an image at 
one time in a full-screen gallery view, which makes it easier to compare and choose between them.



Getting Started
This guide is designed to walk you through Perfect Photos Suite 7. It offers usage guidelines of the Suite as a 
standalone application. When using Perfect Photo Suite 7 as a standalone, you may access the sample images 
from the Browser menu in the Perfect Layers module. You can also find these sample image files in your 
Users>Shared>Pictures>onOne Samples folder automatically after install.

Video Tutorials and Examples
If you would like to see usage examples, video tutorials, and quick tips—they are available at  our learning pages 
www.ononesoftware.com/learn 

Here are a couple of Perfect Photo Suite 7 videos to help you started:
Quick Tour
http://www.ononesoftware.com/learn/training/video/perfect-photo-suite-7-quick-tour
Tips & Tricks

 http://www.ononesoftware.com/learn/training/video/perfect-photo-suite-7-tips-tricks
 
Installation
Full installation instructions can be found in the User Guide available at www.ononesoftware.com/support/
user_guides.html. 

Perfect Photo Suite 7 may be installed alongside Perfect Photo Suite 6, allowing both programs to reside on 
your computer. A dialogue during installation will allow you to select this option.

If you wish to use Perfect Photo Suite 7 through Photoshop, Lightroom, or Aperture—the installer of Perfect 
Photo Suite 7 will automatically find and install the correct components. Make sure Photoshop, Lightroom, and 
Aperture are not running before installing Perfect Photo Suite 7. 

Perfect Photo Suite 7 may be used on its own as a standalone application. After installation it can be found in 
your Start menu on Windows or in the Applications folder on Mac OS X.

At the end of the installation process you will be prompted to activate Perfect Photo Suite 7. Insert the license 
number provided.

Windows Video Card Driver
If you are reviewing Perfect Photo Suite 7 on a Windows-based computer, it is important that you have the latest 
drivers for your video card installed to get the best performance from Perfect Photo Suite.  Learn how to update 
your video card driver at www.ononesoftware.com/support/1564/

Launching Perfect Photo Suite 7
Perfect Photo Suite 7 is flexible and easily accessible from Lightroom, Aperture, Photoshop, Photoshop 
Elements, and as a standalone application. Here is a quick guide for launching from your workflow of choice.

• Adobe Lightroom:  

Option 1: File > Plug-in extras
Option 2: Right-click on file and select Edit-in

• Apple Aperture: Right-click and select Edit with plug-in 

• Adobe Photoshop: 
Option 1: File > Automate 

Option 2: Through the onOne Panel located under Window > Extensions > onOne. When launching 
through Photoshop®, Perfect Photo Suite 7 is a plug-in and the individual modules can be accessed 

one at a time. 

• Adobe Photoshop Elements: File > automation tool (edit mode)

• Standalone: Launch from the Applications folder (Mac) or from All Programs (Win)

To see video tutorials on how to launch Perfect Photo Suite 7, please visit
http://www.ononesoftware.com/learn/training/video/launching-perfect-photo-suite-7

The sample images used in this guide 
are built into the software and appear 

automatically in the browser upon 
launching the standalone application.
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Perfect Layers 3
Experience the Power of Layers without Photoshop
Get a layered file workflow without Photoshop. With Perfect Layers 3, you can combine images and edit 
multilayered files for endless creative options. 

Use Perfect Layers 3 to:

• Extend the editing power of Lightroom and Aperture
• Combine the best parts of multiple photos to balance exposure, swap heads, and create composites
• Retouch portraits and landscapes
• Create layouts with backgrounds, borders, and edges

What’s New 

• Built-in image browser
• More Blending Mode options
• PNG file support
• Perfect Brush with edge detection
• Expanded library of textures and borders

1. Launch Perfect Photo Suite 7 (standalone), browse through “onOne 
Samples,” and open the two images titled sky.jpg and water.jpg by 
double-clicking them and choosing Add.

Launch Perfect Photo Suite 7 (standalone), browse through “onOne 
Samples,” and open the two images titled sky.jpg and water.jpg by 
double-clicking them and choosing Add.

Launch Perfect Photo Suite 7 (standalone), browse through “onOne 
Samples,” and open the two images titled sky.jpg and water.jpg by 
double-clicking them and choosing Add.

2. Notice that each image is now a layer in your Layers stack. Make sure 
the exposure for the water is on the bottom and the darker exposure 
for the sky is on top.

Notice that each image is now a layer in your Layers stack. Make sure 
the exposure for the water is on the bottom and the darker exposure 
for the sky is on top.

Notice that each image is now a layer in your Layers stack. Make sure 
the exposure for the water is on the bottom and the darker exposure 
for the sky is on top.

Mask with the Masking Bug
The masking tools in Perfect Layers allow photographers to selectively blend layers. This is key when 
changing skies, compositing multiple images together, and even swapping heads. 
Let’s use the Masking Bug. It allows photographers a fast and simple way to blend layers using an adjustable 
gradient in either a rectangular or round shape. It is perfect for creating vignettes or changing skies. 

Mask with the Masking Bug
The masking tools in Perfect Layers allow photographers to selectively blend layers. This is key when 
changing skies, compositing multiple images together, and even swapping heads. 
Let’s use the Masking Bug. It allows photographers a fast and simple way to blend layers using an adjustable 
gradient in either a rectangular or round shape. It is perfect for creating vignettes or changing skies. 

Mask with the Masking Bug
The masking tools in Perfect Layers allow photographers to selectively blend layers. This is key when 
changing skies, compositing multiple images together, and even swapping heads. 
Let’s use the Masking Bug. It allows photographers a fast and simple way to blend layers using an adjustable 
gradient in either a rectangular or round shape. It is perfect for creating vignettes or changing skies. 

Mask with the Masking Bug
The masking tools in Perfect Layers allow photographers to selectively blend layers. This is key when 
changing skies, compositing multiple images together, and even swapping heads. 
Let’s use the Masking Bug. It allows photographers a fast and simple way to blend layers using an adjustable 
gradient in either a rectangular or round shape. It is perfect for creating vignettes or changing skies. 

Mask with the Masking Bug
The masking tools in Perfect Layers allow photographers to selectively blend layers. This is key when 
changing skies, compositing multiple images together, and even swapping heads. 
Let’s use the Masking Bug. It allows photographers a fast and simple way to blend layers using an adjustable 
gradient in either a rectangular or round shape. It is perfect for creating vignettes or changing skies. 

3. Select the Masking Bug from the Tool Well on the left side of the 
window. Click on the image over the water in the foreground to 
activate the Masking Bug where you clicked.

Select the Masking Bug from the Tool Well on the left side of the 
window. Click on the image over the water in the foreground to 
activate the Masking Bug where you clicked.

Select the Masking Bug from the Tool Well on the left side of the 
window. Click on the image over the water in the foreground to 
activate the Masking Bug where you clicked.

4. Next, grab one of the legs of the Masking Bug. The legs are the 
shorter appendage with a solid terminal. Rotate the bug 90 degrees 
and stretch it to make it larger. You should see lighter water from the 
underlying layer appear. Continue to adjust the Masking Bug position 
and size until you have revealed all the water and have a natural 
transition at the horizon.

Next, grab one of the legs of the Masking Bug. The legs are the 
shorter appendage with a solid terminal. Rotate the bug 90 degrees 
and stretch it to make it larger. You should see lighter water from the 
underlying layer appear. Continue to adjust the Masking Bug position 
and size until you have revealed all the water and have a natural 
transition at the horizon.

Next, grab one of the legs of the Masking Bug. The legs are the 
shorter appendage with a solid terminal. Rotate the bug 90 degrees 
and stretch it to make it larger. You should see lighter water from the 
underlying layer appear. Continue to adjust the Masking Bug position 
and size until you have revealed all the water and have a natural 
transition at the horizon.

!
TRY IT!

Combine and blend 
layers to create a 

balanced exposure 

Interface Key

A - Image Browser

B - Layers Panel

C - Tool Well

D - Tool Options Bar

E - Browser Preview Mode

F - Module Selector

G - Navigator, Loupe, Histogram
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5. Set the Mask View Mode to Mask Red. This will make it easier to see 
the mask created by the Masking Bug. Now adjust the antennas of 
the Masking Bug. 

• The right antenna controls the opacity of the selected layer 
and the feather or hardness of the mask. 

• The left antenna controls the opacity of the mask.

Return to the Mask View Mode selection to All Layers.

Set the Mask View Mode to Mask Red. This will make it easier to see 
the mask created by the Masking Bug. Now adjust the antennas of 
the Masking Bug. 

• The right antenna controls the opacity of the selected layer 
and the feather or hardness of the mask. 

• The left antenna controls the opacity of the mask.

Return to the Mask View Mode selection to All Layers.

Set the Mask View Mode to Mask Red. This will make it easier to see 
the mask created by the Masking Bug. Now adjust the antennas of 
the Masking Bug. 

• The right antenna controls the opacity of the selected layer 
and the feather or hardness of the mask. 

• The left antenna controls the opacity of the mask.

Return to the Mask View Mode selection to All Layers.

Retouch Brush
The Retouch Brush in Perfect Layers is perfect for quick touch ups. It can be used to remove dust spots, 
power lines, and other distractions from your image.

Retouch Brush
The Retouch Brush in Perfect Layers is perfect for quick touch ups. It can be used to remove dust spots, 
power lines, and other distractions from your image.

Retouch Brush
The Retouch Brush in Perfect Layers is perfect for quick touch ups. It can be used to remove dust spots, 
power lines, and other distractions from your image.

Retouch Brush
The Retouch Brush in Perfect Layers is perfect for quick touch ups. It can be used to remove dust spots, 
power lines, and other distractions from your image.

Retouch Brush
The Retouch Brush in Perfect Layers is perfect for quick touch ups. It can be used to remove dust spots, 
power lines, and other distractions from your image.

6. Combine your sky and water images into a single image by clicking 
on the Merge button. This is similar to flattening your layers in 
Photoshop.

Combine your sky and water images into a single image by clicking 
on the Merge button. This is similar to flattening your layers in 
Photoshop.

Combine your sky and water images into a single image by clicking 
on the Merge button. This is similar to flattening your layers in 
Photoshop.

7. Select the Retouch Brush from the Tool Well. 
Paint over a small cloud and watch it disappear. 
You may adjust the size and opacity of your 
Retouch Brush.

Select the Retouch Brush from the Tool Well. 
Paint over a small cloud and watch it disappear. 
You may adjust the size and opacity of your 
Retouch Brush.

Clone Brush
The Clone Brush is a function of the Retouch Brush.  It may be used to copy areas of your image so that you 
may use the image sample to cover unwanted items in your image.

Clone Brush
The Clone Brush is a function of the Retouch Brush.  It may be used to copy areas of your image so that you 
may use the image sample to cover unwanted items in your image.

Clone Brush
The Clone Brush is a function of the Retouch Brush.  It may be used to copy areas of your image so that you 
may use the image sample to cover unwanted items in your image.

Clone Brush
The Clone Brush is a function of the Retouch Brush.  It may be used to copy areas of your image so that you 
may use the image sample to cover unwanted items in your image.

Clone Brush
The Clone Brush is a function of the Retouch Brush.  It may be used to copy areas of your image so that you 
may use the image sample to cover unwanted items in your image.

8. Check the Use Clone Brush on. Option-Click to 
set your anchor point. Then paint over the area 
you’d like to remove. 

9. Click Apply or Cancel to return to LayersClick Apply or Cancel to return to LayersClick Apply or Cancel to return to Layers

Masking Brush
The Masking Brush allows you to show or hide specific parts of a layer with simple brush strokes. This is 
ideal for swapping heads and creating composites. 

Masking Brush
The Masking Brush allows you to show or hide specific parts of a layer with simple brush strokes. This is 
ideal for swapping heads and creating composites. 

Masking Brush
The Masking Brush allows you to show or hide specific parts of a layer with simple brush strokes. This is 
ideal for swapping heads and creating composites. 

Masking Brush
The Masking Brush allows you to show or hide specific parts of a layer with simple brush strokes. This is 
ideal for swapping heads and creating composites. 

Masking Brush
The Masking Brush allows you to show or hide specific parts of a layer with simple brush strokes. This is 
ideal for swapping heads and creating composites. 

Borders, Textures and PNG Support
Perfect Layers 3 now includes an assortment of borders and textures in the Extras Library. New PNG 
transparency file support built into Perfect Layers 3 allows you to stack, position, and blend these files with 
your image. Along with the Transform, Crop, and Trim tools, it’s easy to create layouts in Perfect Layers 3.

Borders, Textures and PNG Support
Perfect Layers 3 now includes an assortment of borders and textures in the Extras Library. New PNG 
transparency file support built into Perfect Layers 3 allows you to stack, position, and blend these files with 
your image. Along with the Transform, Crop, and Trim tools, it’s easy to create layouts in Perfect Layers 3.

Borders, Textures and PNG Support
Perfect Layers 3 now includes an assortment of borders and textures in the Extras Library. New PNG 
transparency file support built into Perfect Layers 3 allows you to stack, position, and blend these files with 
your image. Along with the Transform, Crop, and Trim tools, it’s easy to create layouts in Perfect Layers 3.

Borders, Textures and PNG Support
Perfect Layers 3 now includes an assortment of borders and textures in the Extras Library. New PNG 
transparency file support built into Perfect Layers 3 allows you to stack, position, and blend these files with 
your image. Along with the Transform, Crop, and Trim tools, it’s easy to create layouts in Perfect Layers 3.

Borders, Textures and PNG Support
Perfect Layers 3 now includes an assortment of borders and textures in the Extras Library. New PNG 
transparency file support built into Perfect Layers 3 allows you to stack, position, and blend these files with 
your image. Along with the Transform, Crop, and Trim tools, it’s easy to create layouts in Perfect Layers 3.
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Remove small 
distractions 



1. Browse through “onOne Samples” and double-click on 
YosemiteBW.jpg. 
Browse through “onOne Samples” and double-click on 
YosemiteBW.jpg. 
Browse through “onOne Samples” and double-click on 
YosemiteBW.jpg. 

2. Click on the Extras tab and open the Textures library. Add a texture to 
your layer stack by double-clicking on your selection and clicking 
Add, such as the Old Parchment.jpg file under the Paper category. 

Click the Transform button  from the Tool Well. Click the Fill 
button from the Tool Options Bar. Click Apply.

Click on the Extras tab and open the Textures library. Add a texture to 
your layer stack by double-clicking on your selection and clicking 
Add, such as the Old Parchment.jpg file under the Paper category. 

Click the Transform button  from the Tool Well. Click the Fill 
button from the Tool Options Bar. Click Apply.

Click on the Extras tab and open the Textures library. Add a texture to 
your layer stack by double-clicking on your selection and clicking 
Add, such as the Old Parchment.jpg file under the Paper category. 

Click the Transform button  from the Tool Well. Click the Fill 
button from the Tool Options Bar. Click Apply.

3. Combine the layers by selecting a Blending Mode. Scroll through 
your options and select the mode of your choice, such as Color Burn. 
Adjust the Opacity to control the strength of the effect.

A dozen new Blending Modes have been added!

Combine the layers by selecting a Blending Mode. Scroll through 
your options and select the mode of your choice, such as Color Burn. 
Adjust the Opacity to control the strength of the effect.

A dozen new Blending Modes have been added!

Combine the layers by selecting a Blending Mode. Scroll through 
your options and select the mode of your choice, such as Color Burn. 
Adjust the Opacity to control the strength of the effect.

A dozen new Blending Modes have been added!

4. Add a border from the Extras Library. Browse Borders > Sloppy 
Borders and double-click Sloppy Border 5. Click Add.

With the Transform tool selected, click on the Fill button to fit your 
border to your image. Click Apply. You may also use a blending mode 
such as Soft Light.

Add a border from the Extras Library. Browse Borders > Sloppy 
Borders and double-click Sloppy Border 5. Click Add.

With the Transform tool selected, click on the Fill button to fit your 
border to your image. Click Apply. You may also use a blending mode 
such as Soft Light.

Add a border from the Extras Library. Browse Borders > Sloppy 
Borders and double-click Sloppy Border 5. Click Add.

With the Transform tool selected, click on the Fill button to fit your 
border to your image. Click Apply. You may also use a blending mode 
such as Soft Light.

5. Shift+Click all three layers. Click Merge. Shift+Click all three layers. Click Merge. Shift+Click all three layers. Click Merge. 

6. Under the Edit menu, select Adjust Canvas Size and change the 
width to 4000 pixels or 50 inches. 
Under the Edit menu, select Adjust Canvas Size and change the 
width to 4000 pixels or 50 inches. 
Under the Edit menu, select Adjust Canvas Size and change the 
width to 4000 pixels or 50 inches. 

7. From the Extras Library, add a background to your workspace, such 
as Studio Backdrop > Backdrop36.jpg. With the Transform tool 
selected, click one of the Rotate Layer buttons to fit your image to the 
horizontal space. Click Fill then Apply. In your layer stack, drag the 
background layer below your main image.

From the Extras Library, add a background to your workspace, such 
as Studio Backdrop > Backdrop36.jpg. With the Transform tool 
selected, click one of the Rotate Layer buttons to fit your image to the 
horizontal space. Click Fill then Apply. In your layer stack, drag the 
background layer below your main image.

From the Extras Library, add a background to your workspace, such 
as Studio Backdrop > Backdrop36.jpg. With the Transform tool 
selected, click one of the Rotate Layer buttons to fit your image to the 
horizontal space. Click Fill then Apply. In your layer stack, drag the 
background layer below your main image.

8. Select the image layer. Make sure you are in Transform mode. Use 
the dark squares around your image to rotate and position your image 
where you want it on your background. 

Select the image layer. Make sure you are in Transform mode. Use 
the dark squares around your image to rotate and position your image 
where you want it on your background. 

Select the image layer. Make sure you are in Transform mode. Use 
the dark squares around your image to rotate and position your image 
where you want it on your background. 

9. To exit, click Close and Don’t Save.To exit, click Close and Don’t Save.To exit, click Close and Don’t Save.
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Create a layout with 
Perfect Layers



A - Tool Well 

B - Tool Options Bar

• Face Select Tool

• Face Edit Tool

• Retouch Brush

• Hand Tool

• Zoom Tool

Perfect Portrait 2

Simply Powerful Portrait Retouching
Perfect Portrait 2 offers photographers the easiest way to create stunning portraits. You can now focus on the 
art of retouching and portrait creation because the most time-consuming tasks have been automated. Get 
great looking and natural skin as Perfect Portrait 2 maintains realistic skin structure so portraits don't look 
over retouched. You can quickly reduce wrinkles and deep pores and smooth skin to an even consistency. 
Perfect Portrait 2 can be used on just the face or the entire body.

Use Perfect Portrait 2 to:
• Smooth skin and remove blemishes
• Enhance eyes and teeth
• Remove red eye
• Correct image color based on skin tone
• Apply custom retouching to each face in your image

What’s New

• More accurate automatic face detection
• Improved instant enhancement of eyes and mouth
• New control points for precise adjustments
• Simplified workflow for multiple faces

Perfect Portrait 2

Simply Powerful Portrait Retouching
Perfect Portrait 2 offers photographers the easiest way to create stunning portraits. You can now focus on the 
art of retouching and portrait creation because the most time-consuming tasks have been automated. Get 
great looking and natural skin as Perfect Portrait 2 maintains realistic skin structure so portraits don't look 
over retouched. You can quickly reduce wrinkles and deep pores and smooth skin to an even consistency. 
Perfect Portrait 2 can be used on just the face or the entire body.

Use Perfect Portrait 2 to:
• Smooth skin and remove blemishes
• Enhance eyes and teeth
• Remove red eye
• Correct image color based on skin tone
• Apply custom retouching to each face in your image

What’s New

• More accurate automatic face detection
• Improved instant enhancement of eyes and mouth
• New control points for precise adjustments
• Simplified workflow for multiple faces

Perfect Portrait 2

Simply Powerful Portrait Retouching
Perfect Portrait 2 offers photographers the easiest way to create stunning portraits. You can now focus on the 
art of retouching and portrait creation because the most time-consuming tasks have been automated. Get 
great looking and natural skin as Perfect Portrait 2 maintains realistic skin structure so portraits don't look 
over retouched. You can quickly reduce wrinkles and deep pores and smooth skin to an even consistency. 
Perfect Portrait 2 can be used on just the face or the entire body.

Use Perfect Portrait 2 to:
• Smooth skin and remove blemishes
• Enhance eyes and teeth
• Remove red eye
• Correct image color based on skin tone
• Apply custom retouching to each face in your image

What’s New

• More accurate automatic face detection
• Improved instant enhancement of eyes and mouth
• New control points for precise adjustments
• Simplified workflow for multiple faces

Perfect Portrait 2

Simply Powerful Portrait Retouching
Perfect Portrait 2 offers photographers the easiest way to create stunning portraits. You can now focus on the 
art of retouching and portrait creation because the most time-consuming tasks have been automated. Get 
great looking and natural skin as Perfect Portrait 2 maintains realistic skin structure so portraits don't look 
over retouched. You can quickly reduce wrinkles and deep pores and smooth skin to an even consistency. 
Perfect Portrait 2 can be used on just the face or the entire body.

Use Perfect Portrait 2 to:
• Smooth skin and remove blemishes
• Enhance eyes and teeth
• Remove red eye
• Correct image color based on skin tone
• Apply custom retouching to each face in your image

What’s New

• More accurate automatic face detection
• Improved instant enhancement of eyes and mouth
• New control points for precise adjustments
• Simplified workflow for multiple faces

Perfect Portrait 2

Simply Powerful Portrait Retouching
Perfect Portrait 2 offers photographers the easiest way to create stunning portraits. You can now focus on the 
art of retouching and portrait creation because the most time-consuming tasks have been automated. Get 
great looking and natural skin as Perfect Portrait 2 maintains realistic skin structure so portraits don't look 
over retouched. You can quickly reduce wrinkles and deep pores and smooth skin to an even consistency. 
Perfect Portrait 2 can be used on just the face or the entire body.

Use Perfect Portrait 2 to:
• Smooth skin and remove blemishes
• Enhance eyes and teeth
• Remove red eye
• Correct image color based on skin tone
• Apply custom retouching to each face in your image

What’s New

• More accurate automatic face detection
• Improved instant enhancement of eyes and mouth
• New control points for precise adjustments
• Simplified workflow for multiple faces

1. In the standalone application, browse through “onOne Samples” and 
find Portrait.jpg. Double-click to open.
In the standalone application, browse through “onOne Samples” and 
find Portrait.jpg. Double-click to open.
In the standalone application, browse through “onOne Samples” and 
find Portrait.jpg. Double-click to open.

2. Click on Portrait from the module selector (top right).Click on Portrait from the module selector (top right).Click on Portrait from the module selector (top right).

!
TRY IT!

Retouch a portrait 
with ease

C - Retouching Controls

D - Skin Tune Controls

E - Mouth and Eye Controls

F - Preview Mode

Interface Key

G - Presets

Tool Well
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Automatic Face Detection
Upon launching Perfect Portrait, it recognizes the areas of skin, eyes, and 
mouths in your image and automatically applies some light adjustments. 
Click on the Preview Mode checkbox to see a before and after. 

Each recognized face will have a square placed around it. Find options 
under the Face menu to add, delete, or reset face recognition. 

Automatic Face Detection
Upon launching Perfect Portrait, it recognizes the areas of skin, eyes, and 
mouths in your image and automatically applies some light adjustments. 
Click on the Preview Mode checkbox to see a before and after. 

Each recognized face will have a square placed around it. Find options 
under the Face menu to add, delete, or reset face recognition. 

Automatic Face Detection
Upon launching Perfect Portrait, it recognizes the areas of skin, eyes, and 
mouths in your image and automatically applies some light adjustments. 
Click on the Preview Mode checkbox to see a before and after. 

Each recognized face will have a square placed around it. Find options 
under the Face menu to add, delete, or reset face recognition. 

Automatic Face Detection
Upon launching Perfect Portrait, it recognizes the areas of skin, eyes, and 
mouths in your image and automatically applies some light adjustments. 
Click on the Preview Mode checkbox to see a before and after. 

Each recognized face will have a square placed around it. Find options 
under the Face menu to add, delete, or reset face recognition. 

3. To make your own adjustments, click inside the box of the face you’d like to work on. You’ll see Eye 
and Mouth Control Points appear. 
To make your own adjustments, click inside the box of the face you’d like to work on. You’ll see Eye 
and Mouth Control Points appear. 
To make your own adjustments, click inside the box of the face you’d like to work on. You’ll see Eye 
and Mouth Control Points appear. 
To make your own adjustments, click inside the box of the face you’d like to work on. You’ll see Eye 
and Mouth Control Points appear. 

Eye and Mouth Control Points
Use the new Eye & Mouth Control Points to refine how the features in your image are recognized, so you 
can easily localize where brightening and color enhancements will appear.

Eye and Mouth Control Points
Use the new Eye & Mouth Control Points to refine how the features in your image are recognized, so you 
can easily localize where brightening and color enhancements will appear.

Eye and Mouth Control Points
Use the new Eye & Mouth Control Points to refine how the features in your image are recognized, so you 
can easily localize where brightening and color enhancements will appear.

Eye and Mouth Control Points
Use the new Eye & Mouth Control Points to refine how the features in your image are recognized, so you 
can easily localize where brightening and color enhancements will appear.

Eye and Mouth Control Points
Use the new Eye & Mouth Control Points to refine how the features in your image are recognized, so you 
can easily localize where brightening and color enhancements will appear.

4. Adjust the control points by click-hold-and-dragging the little squares.  
In the eyes you will notice a cyan colored control point. This point 
should centered on the pupil. With the Reduce Red Eye box checked 
in the Eyes & Mouth pane, any red eyes in this selection will be 
minimized. 

Adjust the control points by click-hold-and-dragging the little squares.  
In the eyes you will notice a cyan colored control point. This point 
should centered on the pupil. With the Reduce Red Eye box checked 
in the Eyes & Mouth pane, any red eyes in this selection will be 
minimized. 

Adjust the control points by click-hold-and-dragging the little squares.  
In the eyes you will notice a cyan colored control point. This point 
should centered on the pupil. With the Reduce Red Eye box checked 
in the Eyes & Mouth pane, any red eyes in this selection will be 
minimized. 

5. The control points inside the mouth adjust the whiteness of the teeth 
and the outer points will adjust the vibrance of the lips.
The control points inside the mouth adjust the whiteness of the teeth 
and the outer points will adjust the vibrance of the lips.
The control points inside the mouth adjust the whiteness of the teeth 
and the outer points will adjust the vibrance of the lips.

6. Click the Hide Controls button, located in the Tool Options Bar.Click the Hide Controls button, located in the Tool Options Bar.Click the Hide Controls button, located in the Tool Options Bar.

Adjust the Skin Selection
When Perfect Portrait finds a face it automatically generates a selection, or mask, for the skin of the face. 
Generally the automatic mask is very good but occasionally you may need to adjust it to add areas of skin, 
especially if you want adjustments applied to areas such as the neck.

Adjust the Skin Selection
When Perfect Portrait finds a face it automatically generates a selection, or mask, for the skin of the face. 
Generally the automatic mask is very good but occasionally you may need to adjust it to add areas of skin, 
especially if you want adjustments applied to areas such as the neck.

Adjust the Skin Selection
When Perfect Portrait finds a face it automatically generates a selection, or mask, for the skin of the face. 
Generally the automatic mask is very good but occasionally you may need to adjust it to add areas of skin, 
especially if you want adjustments applied to areas such as the neck.

Adjust the Skin Selection
When Perfect Portrait finds a face it automatically generates a selection, or mask, for the skin of the face. 
Generally the automatic mask is very good but occasionally you may need to adjust it to add areas of skin, 
especially if you want adjustments applied to areas such as the neck.

Adjust the Skin Selection
When Perfect Portrait finds a face it automatically generates a selection, or mask, for the skin of the face. 
Generally the automatic mask is very good but occasionally you may need to adjust it to add areas of skin, 
especially if you want adjustments applied to areas such as the neck.

7. If necessary, click to open the Face Edit tool (if you’ve followed the 
directions above, it should already be open).
If necessary, click to open the Face Edit tool (if you’ve followed the 
directions above, it should already be open).
If necessary, click to open the Face Edit tool (if you’ve followed the 
directions above, it should already be open).

8. See the areas Perfect Portrait automatically recognized as skin by 
setting the Mask View Mode, located in the bottom left near the 
Preview Mode selection, to Mask-Red.

See the areas Perfect Portrait automatically recognized as skin by 
setting the Mask View Mode, located in the bottom left near the 
Preview Mode selection, to Mask-Red.

See the areas Perfect Portrait automatically recognized as skin by 
setting the Mask View Mode, located in the bottom left near the 
Preview Mode selection, to Mask-Red.

9. From the Tool Options Bar, set your Brush Mode to Add to Skin. 
Adjust the Brush Size and start painting in the areas you’d like to be 
recognized as skin. Repeat these steps for the Brush Mode Not Skin. 
Return your Preview type to After.

From the Tool Options Bar, set your Brush Mode to Add to Skin. 
Adjust the Brush Size and start painting in the areas you’d like to be 
recognized as skin. Repeat these steps for the Brush Mode Not Skin. 
Return your Preview type to After.

From the Tool Options Bar, set your Brush Mode to Add to Skin. 
Adjust the Brush Size and start painting in the areas you’d like to be 
recognized as skin. Repeat these steps for the Brush Mode Not Skin. 
Return your Preview type to After.

Automatic Retouching with Presets
Apply one of the various presets included in Perfect Portrait 2 for Children, Female, Group, or Male subjects. 
Find them in the Library pane of your Browser.

Automatic Retouching with Presets
Apply one of the various presets included in Perfect Portrait 2 for Children, Female, Group, or Male subjects. 
Find them in the Library pane of your Browser.

Automatic Retouching with Presets
Apply one of the various presets included in Perfect Portrait 2 for Children, Female, Group, or Male subjects. 
Find them in the Library pane of your Browser.

Automatic Retouching with Presets
Apply one of the various presets included in Perfect Portrait 2 for Children, Female, Group, or Male subjects. 
Find them in the Library pane of your Browser.

Automatic Retouching with Presets
Apply one of the various presets included in Perfect Portrait 2 for Children, Female, Group, or Male subjects. 
Find them in the Library pane of your Browser.

10. Reveal the drop down menu of presets in the Female category. Reveal the drop down menu of presets in the Female category. Reveal the drop down menu of presets in the Female category. 

11. Click on Heavy, then Natural to see the kind of adjustments that can 
be applied. 
Click on Heavy, then Natural to see the kind of adjustments that can 
be applied. 
Click on Heavy, then Natural to see the kind of adjustments that can 
be applied. 

Manual Adjustment Tools
If you’d like to make further adjustments to your face, use the manual controls in the Skin Retouching, Color 
Correction, and Mouth & Eyes Panes.

Manual Adjustment Tools
If you’d like to make further adjustments to your face, use the manual controls in the Skin Retouching, Color 
Correction, and Mouth & Eyes Panes.

Manual Adjustment Tools
If you’d like to make further adjustments to your face, use the manual controls in the Skin Retouching, Color 
Correction, and Mouth & Eyes Panes.

Manual Adjustment Tools
If you’d like to make further adjustments to your face, use the manual controls in the Skin Retouching, Color 
Correction, and Mouth & Eyes Panes.

Manual Adjustment Tools
If you’d like to make further adjustments to your face, use the manual controls in the Skin Retouching, Color 
Correction, and Mouth & Eyes Panes.

Retouch Brush
The Retouch Brush is also available for specific problem areas. Dab the 
Retouch Brush over scars, wrinkles, pimples and other minor imperfections 
to complete the portrait retouching.  Tip: Lower the Opacity level for more 
natural results.

Retouch Brush
The Retouch Brush is also available for specific problem areas. Dab the 
Retouch Brush over scars, wrinkles, pimples and other minor imperfections 
to complete the portrait retouching.  Tip: Lower the Opacity level for more 
natural results.

Retouch Brush
The Retouch Brush is also available for specific problem areas. Dab the 
Retouch Brush over scars, wrinkles, pimples and other minor imperfections 
to complete the portrait retouching.  Tip: Lower the Opacity level for more 
natural results.

Retouch Brush
The Retouch Brush is also available for specific problem areas. Dab the 
Retouch Brush over scars, wrinkles, pimples and other minor imperfections 
to complete the portrait retouching.  Tip: Lower the Opacity level for more 
natural results.

12. Click Apply or Cancel to return to Layers.Click Apply or Cancel to return to Layers.Click Apply or Cancel to return to Layers.
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Perfect Effects 4

Create Images with Impact
Get an easy, fast, and powerful way to create images with impact. In Perfect Effects 4, choose from a robust 
library of photographic effects to add professional looks to your photos instantly. With the ability to stack, 
combine, blend, and paint in effects to specific areas, your creative options are endless.

Use Perfect Effects 4 to:
• Enhance and stylize images with photographic effects
• Add effects after the shot
• Get instant-click results
• Increase contrast and detail
• Solve common digital photography problems

What’s New
• Flexible browser
• Keyword search function
• Expanded library of photographic effects, frames, and edges
• Improved way to create and share presets
• Paint-in effects
• Favorites

Perfect Effects 4

Create Images with Impact
Get an easy, fast, and powerful way to create images with impact. In Perfect Effects 4, choose from a robust 
library of photographic effects to add professional looks to your photos instantly. With the ability to stack, 
combine, blend, and paint in effects to specific areas, your creative options are endless.

Use Perfect Effects 4 to:
• Enhance and stylize images with photographic effects
• Add effects after the shot
• Get instant-click results
• Increase contrast and detail
• Solve common digital photography problems

What’s New
• Flexible browser
• Keyword search function
• Expanded library of photographic effects, frames, and edges
• Improved way to create and share presets
• Paint-in effects
• Favorites

Perfect Effects 4

Create Images with Impact
Get an easy, fast, and powerful way to create images with impact. In Perfect Effects 4, choose from a robust 
library of photographic effects to add professional looks to your photos instantly. With the ability to stack, 
combine, blend, and paint in effects to specific areas, your creative options are endless.

Use Perfect Effects 4 to:
• Enhance and stylize images with photographic effects
• Add effects after the shot
• Get instant-click results
• Increase contrast and detail
• Solve common digital photography problems

What’s New
• Flexible browser
• Keyword search function
• Expanded library of photographic effects, frames, and edges
• Improved way to create and share presets
• Paint-in effects
• Favorites

Interface Key

A - Effects Library

B - Effects Stack

C - Search Field

D - Tool Well

E - Effects Options

F - Preview Mode

G - Tool Options Bar

1. In the standalone application, browse through “onOne Samples” and 
find Matiash Bridge.jpg. Double-click to open. 

2. Click Effects in the Module Selector. 

!
TRY IT!

Add professional 
effects to an image
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New Flexible Browser
On the left, you will find the new browser, where you can navigate by 
category, create favorites, search keywords, and access presets.  

New Flexible Browser
On the left, you will find the new browser, where you can navigate by 
category, create favorites, search keywords, and access presets.  

Photographic Effects
Enhance and stylize images with the robust library of professional effects included in Perfect Effects 4. With 
just a single click, you can instantly add popular HDR or vintage looks to your image, recreate the look of film 
and darkroom techniques, and more. You can also add depth and dimension with texture effects, highlight 
with glows, simulate filters after the shot, and enhance detail and color. 

Photographic Effects
Enhance and stylize images with the robust library of professional effects included in Perfect Effects 4. With 
just a single click, you can instantly add popular HDR or vintage looks to your image, recreate the look of film 
and darkroom techniques, and more. You can also add depth and dimension with texture effects, highlight 
with glows, simulate filters after the shot, and enhance detail and color. 

Photographic Effects
Enhance and stylize images with the robust library of professional effects included in Perfect Effects 4. With 
just a single click, you can instantly add popular HDR or vintage looks to your image, recreate the look of film 
and darkroom techniques, and more. You can also add depth and dimension with texture effects, highlight 
with glows, simulate filters after the shot, and enhance detail and color. 

3. Click on the Effects tab to see all categories and effects included in 
Perfect Effects 4.

4. View your effects in a single, two, or three-column list or as a text list. 
Use the Browser Preview Mode buttons under the browser menu to 
change your view settings. 

Additionally, the browser is adjustable. It can be minimized or 
expanded by clicking on the center edge of the library and dragging. 

5. Click on any of the effects to see what it looks like on your image. The 
Live Preview will allow you to see how the effect looks on your image 
in real time. 

Previews are cumulative. With every effect you add to your Effects 
Stack, you’ll see it applied to every preview in the library.

6. Mark the effects and presets that you like the most and use most 
often by clicking on the flag next to the effect name. Get to them 
quickly and easily from your Favorites panel.

Quick View Browser
In Perfect Effects, you can use the Quick View Browser to preview effect or preset categories on your image 
at one time so you may compare and select the look you want to apply. You may also drill down to find the 
effect or preset you want.

Quick View Browser
In Perfect Effects, you can use the Quick View Browser to preview effect or preset categories on your image 
at one time so you may compare and select the look you want to apply. You may also drill down to find the 
effect or preset you want.

Quick View Browser
In Perfect Effects, you can use the Quick View Browser to preview effect or preset categories on your image 
at one time so you may compare and select the look you want to apply. You may also drill down to find the 
effect or preset you want.

7. Click on the Quick View Browser icon to open up a gallery view of 
effects and presets. 
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8. In the upper left hand corner, you will find a Back button and 
breadcrumbs to navigate your folders. In the lower left, you can adjust 
the size of your preview thumbnails. 

Keyboard short cuts are also available to navigate through the Quick 
View Browser with a natural ease:

Arrow Keys: Navigate left, right, up and down
Return Key: Selects an item or opens up a folder
[Command+L] or [Ctrl+L]: Goes up a folder level

Select an effect or Close using the button in the lower right. 

Masking Tools
Any of the effects from the Effect Library may be selectively applied to specific parts of your photo. Use the 
Masking Brush to apply or remove effects to specific areas with simple brush strokes and the Masking Bug 
to quickly create vignettes and graduated filter looks. 

Masking Tools
Any of the effects from the Effect Library may be selectively applied to specific parts of your photo. Use the 
Masking Brush to apply or remove effects to specific areas with simple brush strokes and the Masking Bug 
to quickly create vignettes and graduated filter looks. 

Masking Tools
Any of the effects from the Effect Library may be selectively applied to specific parts of your photo. Use the 
Masking Brush to apply or remove effects to specific areas with simple brush strokes and the Masking Bug 
to quickly create vignettes and graduated filter looks. 

9. Enter ‘grunge’ into the Search box and select the effect Grunge 
Goddess. Click it to apply. Note: Single-clicking an effect will apply it 
to a current layer. Double-clicking an effect will apply it to the current 
layer and automatically add a new layer.

10. Click on your Masking Brush from your Tool Well. Click the Invert 
button from your Tool Options Bar and make sure your Brush Mode 
is set to Paint In. Check the Perfect Brush.

11.. Paint the bridge and see the Grunge Goddess effect appear in just 
the area you are brushing. Set your Mask View mode to ensure you 
are placing the mask where you want.

Paint-in Effects with Basic Brushes
You can also use the Basic Brushes from the Effects Library to paint-in effects on specific areas of your 
image. The Basic Brushes allow you to make areas darker or lighter, add detail or color, and more to solve 
some of your most common digital photography problems. 

Paint-in Effects with Basic Brushes
You can also use the Basic Brushes from the Effects Library to paint-in effects on specific areas of your 
image. The Basic Brushes allow you to make areas darker or lighter, add detail or color, and more to solve 
some of your most common digital photography problems. 

Paint-in Effects with Basic Brushes
You can also use the Basic Brushes from the Effects Library to paint-in effects on specific areas of your 
image. The Basic Brushes allow you to make areas darker or lighter, add detail or color, and more to solve 
some of your most common digital photography problems. 

12. Add an empty layer to your Effects Stack.

13. Select the Basic Brushes from the Effects Library. Click on the Brush 
Cooler effect. Be sure to turn on the Perfect Brush from the Tool 
Options Bar. Adjust your Brush Size, if you like.

14. Begin to paint the sky area with the Brush Cooler effect and notice 
the crosshairs in the middle of the brush. This is the sampling area 
and the brush will only paint the effect into areas that match the color 
being sampled in the crosshairs. This allows you to quickly go around 
edges of the bridge without being precise with your strokes. 

Pictured on the right with the Mask Mode turned on, you can see the 
brush paints in all the blue while leaving the integrity of the bridge. 
Continue to paint the Brush Cooler effect over the entire sky.

15. The Perfect Brush can also automatically detect and protect edges 
using color sampling. Simply hold down the Command key on a Mac 
or the Control key on Windows while using the Perfect Brush and it 
will lock the sampled color until you release the key. This will be 
helpful when brushing through complex areas such as branches, 
trees, and window panes.
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specific parts of your 
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Advanced Technique—Copy and Reuse a Mask
You can make a copy of any mask you create. This makes it faster and easier to apply another effect to an 
exact area you’ve already identified. 

Advanced Technique—Copy and Reuse a Mask
You can make a copy of any mask you create. This makes it faster and easier to apply another effect to an 
exact area you’ve already identified. 

Advanced Technique—Copy and Reuse a Mask
You can make a copy of any mask you create. This makes it faster and easier to apply another effect to an 
exact area you’ve already identified. 

16. Ensure the Brush Cooler layer is selected. Choose Mask > Copy 
Mask from the top menu. 

17. Add a new layer effect to the top of your stack.  

18. Search for “cross process” and select the Cross Process Blue effect 
from the search results. Choose Mask > Paste Mask from the top 
menu. To adjust the strength of the effect, use the slider in the Effect 
Options pane. Set to 50.

19. Add one last empty layer then add the finishing touch of a vignette. 
Search “vignette” and select Subtle Vignette for a classic dark-edge 
look.  

Stack and Combine Layers
Easily stack multiple effects together to create your own unique look. 
Stack and Combine Layers
Easily stack multiple effects together to create your own unique look. 

20. Click Cancel and OK to return to Layers.
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Perfect B&W

The pinnacle for many photographers is the perfectly mastered black and white print. With Perfect B&W, you 
can easily develop your own stunning black and white images. Its powerful and intuitive tools give you instant 
results with complete creative control. Use Perfect B&W to add dramatic and elegant looks to your photos and 
create the many moods black and white photography can evoke—resulting in beautiful and provocative 
imagery.

Use Perfect B&W to:

• Capture the many moods of black and white
• Reproduce time-honored processing techniques
• Enhance contrast, tone, and detail after the shot

Interface Key

A - Browser Section

B - Tool Well

C - Control Panes of Adjustment 
Sliders

D - Tool Options Bar

• Brightness Brush

• Contrast Brush

• Detail Brush

• Targeted Brightness

• Selective Color Brush

• Move Tool

• Zoom Tool

1. Launch the Perfect Photo Suite 7 standalone application. Browse the 
“onOne Samples” and open YosemiteBW.jpg and double-click to open.

2. Click on B&W in the module selector.

Black and White Effects
Reproduce vintage style with the library of expertly crafted effect presets available in Perfect B&W. 
Black and White Effects
Reproduce vintage style with the library of expertly crafted effect presets available in Perfect B&W. 
Black and White Effects
Reproduce vintage style with the library of expertly crafted effect presets available in Perfect B&W. 

3. Browse through the Effects Library to find a desired monochromatic 
look. Navigate through the categories, such as 20th Century Class 
Silver or search for “Ansel.” Select the effect preset Ansel in the Valley 
and click once to apply. 

!
TRY IT!

Convert an image 
to black and white

Tool Well
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4. Navigate to the Color Response in the Control Pane and click on the Infrared 
circle. Notice the boost in the sky.  
Navigate to the Color Response in the Control Pane and click on the Infrared 
circle. Notice the boost in the sky.  

Adjustment Brushes
Perfect B&W features several adjustment brushes for local control. These brush tools (Brightness, Contrast, 
Detail, and Selective Color) mimic darkroom techniques like burning, dodging, bleaching, and reducing.

Adjustment Brushes
Perfect B&W features several adjustment brushes for local control. These brush tools (Brightness, Contrast, 
Detail, and Selective Color) mimic darkroom techniques like burning, dodging, bleaching, and reducing.

Adjustment Brushes
Perfect B&W features several adjustment brushes for local control. These brush tools (Brightness, Contrast, 
Detail, and Selective Color) mimic darkroom techniques like burning, dodging, bleaching, and reducing.

Adjustment Brushes
Perfect B&W features several adjustment brushes for local control. These brush tools (Brightness, Contrast, 
Detail, and Selective Color) mimic darkroom techniques like burning, dodging, bleaching, and reducing.

5. Grab the Targeted Brightness tool, click and hold 
on the area that was formerly blue sky, drag the 
arrows to the left to darken.

6. Now use the Contrast Brush and paint over the 
Grand Tetons.

Hint: Make sure to have the Perfect Brush option 
checked in the Tool Options Bar to target the cliff 
and avoid painting brightness into the sky above or 
the trees below.

7. Select the Brightness Brush and set the mode to 
Darken in the Tools Option Bar. Paint the bottom 
foreground of the forest to achieve a compelling 
vignette.

8. Click Apply or Cancel to return to Layers

Manual Control Panes 
Reproduce vintage styles with adjustment controls designed to replicate darkroom processing techniques. 

• Tone controls the global tonality with sliders, or brightness and contrast of the image. In the Tone Pane, 
you can adjust each of the following: brightness, contrast, blacks, whites, auto levels, shadows, 
highlights, and detail.

• Color Response controls the black and white conversion. You can get the effect of photographic filters 
after the shot. The Color Response pane includes presets based on different color filter options and 
manual sliders to increase or decrease the brightness of each color range.

• Tone Curve controls the global tonality of the images with an adjustable curve. 
• Film Grain loads an overlay of scanned film grain, from popular black and white films, to add the 

appearance of film grain. 
• Toner simulates different chemical toners or paper types used in the darkroom, such as copper, 

cyanotype, selenium, or sepia. Or you can build your own.
• Vignette & Border creates flexible vignettes and authentic film and darkroom edge effects.
• Border creates flexible print edges which can be adjusted with blending modes, size, and opacity.
• Sharpening controls overall sharpness of an image.
• Blending allows you to blend the black and white version with the original color image. With this you 

can create subtle antique, hand-colored, or grunge looks.

Manual Control Panes 
Reproduce vintage styles with adjustment controls designed to replicate darkroom processing techniques. 

• Tone controls the global tonality with sliders, or brightness and contrast of the image. In the Tone Pane, 
you can adjust each of the following: brightness, contrast, blacks, whites, auto levels, shadows, 
highlights, and detail.

• Color Response controls the black and white conversion. You can get the effect of photographic filters 
after the shot. The Color Response pane includes presets based on different color filter options and 
manual sliders to increase or decrease the brightness of each color range.

• Tone Curve controls the global tonality of the images with an adjustable curve. 
• Film Grain loads an overlay of scanned film grain, from popular black and white films, to add the 

appearance of film grain. 
• Toner simulates different chemical toners or paper types used in the darkroom, such as copper, 

cyanotype, selenium, or sepia. Or you can build your own.
• Vignette & Border creates flexible vignettes and authentic film and darkroom edge effects.
• Border creates flexible print edges which can be adjusted with blending modes, size, and opacity.
• Sharpening controls overall sharpness of an image.
• Blending allows you to blend the black and white version with the original color image. With this you 

can create subtle antique, hand-colored, or grunge looks.

Manual Control Panes 
Reproduce vintage styles with adjustment controls designed to replicate darkroom processing techniques. 

• Tone controls the global tonality with sliders, or brightness and contrast of the image. In the Tone Pane, 
you can adjust each of the following: brightness, contrast, blacks, whites, auto levels, shadows, 
highlights, and detail.

• Color Response controls the black and white conversion. You can get the effect of photographic filters 
after the shot. The Color Response pane includes presets based on different color filter options and 
manual sliders to increase or decrease the brightness of each color range.

• Tone Curve controls the global tonality of the images with an adjustable curve. 
• Film Grain loads an overlay of scanned film grain, from popular black and white films, to add the 

appearance of film grain. 
• Toner simulates different chemical toners or paper types used in the darkroom, such as copper, 

cyanotype, selenium, or sepia. Or you can build your own.
• Vignette & Border creates flexible vignettes and authentic film and darkroom edge effects.
• Border creates flexible print edges which can be adjusted with blending modes, size, and opacity.
• Sharpening controls overall sharpness of an image.
• Blending allows you to blend the black and white version with the original color image. With this you 

can create subtle antique, hand-colored, or grunge looks.

Manual Control Panes 
Reproduce vintage styles with adjustment controls designed to replicate darkroom processing techniques. 

• Tone controls the global tonality with sliders, or brightness and contrast of the image. In the Tone Pane, 
you can adjust each of the following: brightness, contrast, blacks, whites, auto levels, shadows, 
highlights, and detail.

• Color Response controls the black and white conversion. You can get the effect of photographic filters 
after the shot. The Color Response pane includes presets based on different color filter options and 
manual sliders to increase or decrease the brightness of each color range.

• Tone Curve controls the global tonality of the images with an adjustable curve. 
• Film Grain loads an overlay of scanned film grain, from popular black and white films, to add the 

appearance of film grain. 
• Toner simulates different chemical toners or paper types used in the darkroom, such as copper, 

cyanotype, selenium, or sepia. Or you can build your own.
• Vignette & Border creates flexible vignettes and authentic film and darkroom edge effects.
• Border creates flexible print edges which can be adjusted with blending modes, size, and opacity.
• Sharpening controls overall sharpness of an image.
• Blending allows you to blend the black and white version with the original color image. With this you 

can create subtle antique, hand-colored, or grunge looks.

Zones View
In Perfect B&W, you can view simulate the 11 zones of the Zone System. It updates in realtime as you make 
changes. 

Zones View
In Perfect B&W, you can view simulate the 11 zones of the Zone System. It updates in realtime as you make 
changes. 

Zones View
In Perfect B&W, you can view simulate the 11 zones of the Zone System. It updates in realtime as you make 
changes. 

Zones View
In Perfect B&W, you can view simulate the 11 zones of the Zone System. It updates in realtime as you make 
changes. 

Access this view from the Mask View mode drop-down 
menu.
Access this view from the Mask View mode drop-down 
menu.
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Perfect Mask 5.2

The Essential Cut Out Tool for Photographers

Perfect Mask is the next generation of Mask Pro, the leading software for background replacement. Perfect 
Mask takes the core strengths of Mask Pro to another level, by automating many common masking tasks with 
incredible accuracy.

Perfect Mask's masking technology makes selecting subjects and isolating backgrounds surprisingly easy. 
With Automatic Background Removal, an initial mask can be made on your image and can then be fine-tuned 
using the Keep, Drop and Refine Tools. With these features, you can create high quality masks in just a few 
clicks. You'll be amazed at how well this works even when masking tough subjects, like hair and glass on 
complex backgrounds.

Use Perfect Mask 5.2 to:

• Remove backgrounds with ease
• Create high-quality masks in just a few clicks
• Cut around the tough stuff easily

What’s New

• Improved user interface
• Keep Brush

• Drop Brush

• Refine Brush

• Basic Brush

• Magic Brush

• Color Spill Tool

• Keep Eyedropper

• Drop Eyedropper

• Pen Tool

• Chisel Tool

• Blur Tool

• Bucket Tool

• Pan Tool

• Zoom Tool

Tool Well

A - Tool Well 

B - Tool Options Bar

C - Adjust Mask Pane

D - Colors Pane

Interface Key
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!
TRY IT!

Remove and replace 
a background

1. Launch the Perfect Photo Suite 7 standalone application. Browse 
“onOne Samples” for Broken Top.jpg and double-click to open.  

2. Open the Extras tab above the image browser.

3. Navigate to Backgrounds > Skies > Skies01.jpg and double-click to 
open.

A message will appear “An image is already open. Do you want to 
add your selected image as new layers, or do you want to create a 
new image?” 

Click Add.

4. With the skies01 layer active use the Transform tool to reposition the 
sky.

Hint: With the Transform tool selected, click Fill on the Tools Option 
Bar. Next drag the image up so the horizon lines up. Click Apply to 
save the transformation.  

5. Simply click+hold and drag the Broken Top layer above the skies01 
layer. Now we are ready to mask.

6. Click Mask on the module selector.

Remove Current Background
The first step in masking most images is to use the Drop Brush and make large brush strokes through areas 
you want to remove. The brush strokes you make will automatically be expanded to similar color and textured 
segments. The Drop Brush offers a fast way to remove large sections in a single stroke.

Remove Current Background
The first step in masking most images is to use the Drop Brush and make large brush strokes through areas 
you want to remove. The brush strokes you make will automatically be expanded to similar color and textured 
segments. The Drop Brush offers a fast way to remove large sections in a single stroke.

Remove Current Background
The first step in masking most images is to use the Drop Brush and make large brush strokes through areas 
you want to remove. The brush strokes you make will automatically be expanded to similar color and textured 
segments. The Drop Brush offers a fast way to remove large sections in a single stroke.

7. Use the Drop Brush and paint a broad stroke over the dull sky. You 
will see the new background layer appear under your brush strokes. If 
you did not add a new background while in Perfect Layers, the area 
removed will have a transparent quality.

8. If too much information has been removed from the mountain range 
paint it back in using the Basic Brush set the mode to Paint in from 
the Tool Options Bar.

9.

 Grab the Chisel tool, which is used for removing fringes or 
halos along hard edges. Paint the mountain to get rid of any halo left 
behind.
 

10. Click Apply or Cancel to return to Layers
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FocalPoint 2 

Control depth of field and creative blur after the shot

FocalPoint 2 is an amazing application that allows you to simulate the blur and depth of field you would think 
could only be done in camera. If you can't shoot a f/1.2 or even f/2.8, yet want that soft, creamy background—use 
FocalPoint to save the day.

FocalPoint lets you create realistic selective focus, depth of field and vignette effects that tell your viewers 
exactly where to look. The intuitive FocusBug controller is just like using a tilt-shift or selective focus lens inside 
your computer.

Set your area of focus and then select a lens to simulate or create your own by controlling the amount and kind 
of blur, even in 3D. With the FocusBrush tool, you can paint sharpness or blur where you want it. It has never 
been easier or faster to focus your viewer's eye and minimize distractions.

Use FocalPoint 2 to:

• Create the look of fast, expensive lenses instantly
• Control depth of field after the shot
• Simulated the creative look of tilt-shift lenses
• Enhance images with highlights and vignettes

1. Open the Perfect Photo Suite 7 stand alone application. Browse 
“onOne Samples” for focalpoint.jpg and double-click to open. 
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2. Click on Focus in the module selector.

FocusBug
The FocusBug puts the most commonly used options in a single, easy-to-use control so you can define the 
area you want to keep in focus. Using the FocusBug is a fluid, real-time experience, just like using a lens but 
inside Perfect Photo Suite 7. You can even tilt the FocusBug in 3D, creating swing and tilt movements just like 
a tilt-shift lens.

FocusBug
The FocusBug puts the most commonly used options in a single, easy-to-use control so you can define the 
area you want to keep in focus. Using the FocusBug is a fluid, real-time experience, just like using a lens but 
inside Perfect Photo Suite 7. You can even tilt the FocusBug in 3D, creating swing and tilt movements just like 
a tilt-shift lens.

FocusBug
The FocusBug puts the most commonly used options in a single, easy-to-use control so you can define the 
area you want to keep in focus. Using the FocusBug is a fluid, real-time experience, just like using a lens but 
inside Perfect Photo Suite 7. You can even tilt the FocusBug in 3D, creating swing and tilt movements just like 
a tilt-shift lens.

3. Your image should open with a round FocalBug showing. If is not, 
under the Edit menu, select Reset All. 

4. Select the Planar Shape in the drop down menu of your FocusBug 
pane.

5. Next grab one of the legs of the FocusBug. The legs are the shorter 
appendage with a solid terminal. Rotate the bug 90 degrees and 
stretch it to make it larger. Click, hold and drag inside the body of the 
FocusBug to position it over the center of the bridge.

Lens Simulator
Lens presets are built into FocalPoint 2 and simulate highly desired, expensive lenses that produce a bokeh, or 
out of focus region with a specific look.

Lens Simulator
Lens presets are built into FocalPoint 2 and simulate highly desired, expensive lenses that produce a bokeh, or 
out of focus region with a specific look.

Lens Simulator
Lens presets are built into FocalPoint 2 and simulate highly desired, expensive lenses that produce a bokeh, or 
out of focus region with a specific look.

6. Apply one of the lens presets from the Lens drop down menu in the 
Blur panel. Select the Canon 35 1.4 at 1.4 preset

Highlight Bloom
FocalPoint 2 includes a Highlight Bloom tool which controls how strong highlights are in the bokeh or blurred 
area.

Highlight Bloom
FocalPoint 2 includes a Highlight Bloom tool which controls how strong highlights are in the bokeh or blurred 
area.

Highlight Bloom
FocalPoint 2 includes a Highlight Bloom tool which controls how strong highlights are in the bokeh or blurred 
area.

7. Increase you Highlight Bloom with the slider in the Options panel to 
~375 to really make the lights in the background pop.

3D Tilt Controls
Use the FocusBug to tilt your plane of focus just like using a tilt-shift lens or view camera. This will vary the blur 
on each side of the sweet spot. 

3D Tilt Controls
Use the FocusBug to tilt your plane of focus just like using a tilt-shift lens or view camera. This will vary the blur 
on each side of the sweet spot. 

3D Tilt Controls
Use the FocusBug to tilt your plane of focus just like using a tilt-shift lens or view camera. This will vary the blur 
on each side of the sweet spot. 

8. Hold down the option (Mac) Alt (win) key, click on the center of the 
FocusBug, then drag your mouse down to create a counter-tilt of 30 
degrees.

Vignette Tools
Apply a vignette to your image—a classic method for focusing your viewer’s eye on your subject—easily with 
FocalPoint. 

Vignette Tools
Apply a vignette to your image—a classic method for focusing your viewer’s eye on your subject—easily with 
FocalPoint. 

Vignette Tools
Apply a vignette to your image—a classic method for focusing your viewer’s eye on your subject—easily with 
FocalPoint. 

9. To see your before and after, turn the Preview, located on your 
bottom tool bar, off and back on.

Close the image. Do not save.

10. Click Apply or Cancel to return to Layers.

Lens Presets

!
TRY IT!

Create a realistic 
depth of field

onOne Software Perfect Photo Suite 7 Reviewer’s Guide 19



Perfect Resize 7.5 

Everything You Need to Prepare Your Images for Print

Perfect Resize 7.5, powered by Genuine Fractals technology, is the industry standard for image resizing. It is 
renowned across the photographic and printing industries for its ability to increase image size well over 1000% 
without the typical loss of sharpness or detail. Additional tools make Perfect Resize ideal for enlarging and 
preparing all types of images for print and display. Use it with all of your images, whether shot with a DSLR 
camera or a mobile device.

Use Perfect Resize to:
• Enlarge images up to 1000% without sacrificing quality
• Maintain the sharpness and detail of your original image
• Crop and resize images to any print size in one step
• Get amazing enlargements from your mobile phone

What’s New in Perfect Resize 7.5
• Faster processing speeds
• Factory presets for optimal output

Interface Key

A - Preset Browser

B - Tool Well

C - Control Panel

1. Launch the Perfect Photo Suite 7 standalone application.  
Browse “onOne Samples” for Leaves.jpg. Double-click to 
open.  

Launch the Perfect Photo Suite 7 standalone application.  
Browse “onOne Samples” for Leaves.jpg. Double-click to 
open.  
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!
TRY IT!

Enlarge an image

Output Presets Browser

2. Click Resize from the module selector.Click Resize from the module selector.

Enlarge Images 
The simple design makes enlarging images easy. You can choose from popular presets built in or you can 
enter a custom dimension, size, or resolution. 

Enlarge Images 
The simple design makes enlarging images easy. You can choose from popular presets built in or you can 
enter a custom dimension, size, or resolution. 

Enlarge Images 
The simple design makes enlarging images easy. You can choose from popular presets built in or you can 
enter a custom dimension, size, or resolution. 

Enlarge Images 
The simple design makes enlarging images easy. You can choose from popular presets built in or you can 
enter a custom dimension, size, or resolution. 

3. Currently, this image is approximately 10x8 at 300 pixels 
per inch as seen in the Control Panel under Document 
Size.

From the Preset drop-down, select Photographic > 30x40 
preset. This enlarges the image by 400% and shows 
where the image is set to crop. See the increased File 
Size in the Pixel Dimension pane.

Currently, this image is approximately 10x8 at 300 pixels 
per inch as seen in the Control Panel under Document 
Size.

From the Preset drop-down, select Photographic > 30x40 
preset. This enlarges the image by 400% and shows 
where the image is set to crop. See the increased File 
Size in the Pixel Dimension pane.

Factory Presets for Optimal Output
Automatically crop, resize, and adjust the sharpening of your image with the new factory presets in Perfect 
Resize 7 Pro. Find presets for specific printer manufacturers and paper types that address subtle but 
important changes that need to be made in resolution and sharpening for optimal output.

Factory Presets for Optimal Output
Automatically crop, resize, and adjust the sharpening of your image with the new factory presets in Perfect 
Resize 7 Pro. Find presets for specific printer manufacturers and paper types that address subtle but 
important changes that need to be made in resolution and sharpening for optimal output.

Factory Presets for Optimal Output
Automatically crop, resize, and adjust the sharpening of your image with the new factory presets in Perfect 
Resize 7 Pro. Find presets for specific printer manufacturers and paper types that address subtle but 
important changes that need to be made in resolution and sharpening for optimal output.

Factory Presets for Optimal Output
Automatically crop, resize, and adjust the sharpening of your image with the new factory presets in Perfect 
Resize 7 Pro. Find presets for specific printer manufacturers and paper types that address subtle but 
important changes that need to be made in resolution and sharpening for optimal output.

4. In the Preset Browser, find Epson Canvas and click on 
Epson 24x36 Gallery Wrap. Notice the image will 
automatically be resized and activate Perfect Resize’s 
Gallery Wrap feature, which extends the margins for 
printing on canvas.  

In the Preset Browser, find Epson Canvas and click on 
Epson 24x36 Gallery Wrap. Notice the image will 
automatically be resized and activate Perfect Resize’s 
Gallery Wrap feature, which extends the margins for 
printing on canvas.  

Preset Settings
Please feel free to explore presets that may better suit your 
print setup. Notice a preset’s detailed settings when you hold 
the cursor over the preset name.  

Preset Settings
Please feel free to explore presets that may better suit your 
print setup. Notice a preset’s detailed settings when you hold 
the cursor over the preset name.  

5. View the enlarged image at a 1:1 ratio by clicking 100 in 
the navigator.

Use the blue square in the Navigator window to quickly 
review areas of the image to examine the sharpness of 
the image detail. 

View the enlarged image at a 1:1 ratio by clicking 100 in 
the navigator.

Use the blue square in the Navigator window to quickly 
review areas of the image to examine the sharpness of 
the image detail. 

6. Click Apply or Cancel to return to Layers.Click Apply or Cancel to return to Layers.
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Press Contacts

Press Contact: 
Amy Chan 
achan@ononesoftware.com, 
503-968-1468 x 137

Online press center:
www.ononesoftware.com/press

onOne Software Blog: 
www.ononesoftware.com/blog

Facebook:
www.facebook.com/
onOneSoftware

Twitter: 
www.twitter.com/onOneSoftware

Google Plus:
www.onOneSoftware.com/plus

Summary

Thank you for taking the time to review Perfect Photo Suite 7 from onOne Software.

Pricing and Availability
Three different versions of Perfect Photo Suite 7 are available, offering users with the option of selection the 
option that matches their workflow and budget needs. The three versions are Perfect Photo Suite 7 Premium 
Edition ($299.95), Perfect Photo Suite for Lightroom & Aperture ($149.95), and Perfect Photo Suite Standard 
Edition ($79.95). 

Perfect Photo Suite 7 Premium Edition is the complete professional suite for every workflow. It works with 
Adobe Photoshop, Photoshop Elements, Lightroom, Apple Aperture, and as a standalone application.

Perfect Photo Suite 7 for Lightroom & Aperture is a powerful editing and creative tool and perfect companion 
for a Lightroom or Aperture workflow. It also works as a standalone application.

Perfect Photo Suite 7 Standard Edition makes it easy to snap, edit, then save without any host application. This 
edition may only be used as a standalone application.

For a full comparison of these editions, please visit www.ononesoftware.com/products/suite7/purchase

Customers may purchase any of these editions at www.ononesoftware.com/store. Perfect Photo Suite Standard 
Edition is also available on the Apple App Store.

Customers who have purchased Perfect Photo Suite 6 on or after August 1, 2012, onOne Software will issue a 
complimentary upgrade to Perfect Photo Suite 7 via download.  Upgrade pricing is available for previous owners 
of Perfect Photo Suite.  

About onOne Software, Inc.
onOne Software, Inc., is a leading developer of photo effects software and apps for anyone who enjoys making 

their pictures look great. onOne Software products include effects and presets that enhance and stylize images 

with sought-after photographic looks of yesterday and today, and powerful photo editing tools that allow users 

to fine tune the effects—to create personalized and unique looks of their own. They are designed to help users 

create amazing images wherever and whenever they are taking pictures, on any device.  

onOne Software solutions include a range of easy-to-use standalone applications; plug-in software for Adobe 

Photoshop, Photoshop Elements, Photoshop Lightroom, and Apple Aperture; apps for the iPhone®  and iPad®; 

and presets for Lightroom. Founded in 2005, onOne Software is a privately held company located in Portland, 

Oregon. Founded in 2005, onOne Software is a privately held company located in Portland, Oregon. For 

additional information, visit www.ononesoftware.com or call 1-888-968-1468. 
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